AREA
INVESTMENT

STRATEGY
MODEL

Version 1.6

©1996--2001 EPRI

USER’S MANUAL



© 1996, 1997, 1998, 1999, 2000, 2001 Electric Power Research Institute (EPRI), Inc.
All rights reserved. Electric Power Research Institute and EPRI are registered service
marks of the Electric Power Research Institute, Inc. EPRI. POWERING PROGRESS
is a service mark of the Electric Power Research Institute, Inc.



User’s Manual

Area Investment Strategy
Model

Version 1.6
©1996 -- 2001 EPRI

Prepared by

Stephen W. Chapel, EPRI

Charles D. Feinstein, VMN Group LLC

Peter A. Morris, VMN Group LCC

Mukund N. Thapa, Stanford Business Software

il



DISCLAIMER OF WARRANTIES AND LIMITATION OF LIABILITIES

THIS PACKAGE WAS PREPARED BY THE ORGANIZATION(S) NAMED
BELOW AS AN ACCOUNT OF WORK SPONSORED OR COSPONSORED BY
THE ELECTRIC POWER RESEARCH INSTITUTE, INC. (EPRI). NEITHER EPRI,
ANY MEMBER OF EPRI, ANY COSPONSOR, THE ORGANIZATION(S)
NAMED BELOW, NOR ANY PERSON ACTING ON BEHALF OF ANY OF
THEM:

(A) MAKES ANY WARRANTY OR REPRESENTATION WHATSOEVER,
EXPRESS OR IMPLIED, (I) WITH RESPECT TO THE USE OF ANY
INFORMATION, APPARATUS, METHOD, PROCESS, OR SIMILAR ITEM
DISCLOSED IN THIS PACKAGE, INCLUDING MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE, OR (II) THAT SUCH USE DOES
NOT INFRINGE ON OR INTERFERE WITH PRIVATELY OWNED RIGHTS,
INCLUDING ANY PARTY'S INTELLECTUAL PROPERTY, OR (IIT) THAT THIS
PACKAGE IS SUITABLE TO ANY PARTICULAR USER'S CIRCUMSTANCE;
OR

(B) ASSUMES RESPONSIBILITY FOR ANY DAMAGES OR OTHER
LIABILITY WHATSOEVER (INCLUDING ANY CONSEQUENTIAL DAMAGES,
EVEN IF EPRI OR ANY EPRI REPRESENTATIVE HAS BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES) RESULTING FROM YOUR
SELECTION OR USE OF THIS PACKAGE OR ANY INFORMATION,
APPARATUS, METHOD, PROCESS, OR SIMILAR ITEM DISCLOSED IN THIS
PACKAGE.

ORGANIZATION(S) THAT PREPARED THIS PACKAGE

Stanford Business Software
PO Box 60398
Palo Alto, CA 94306-0398

ORDERING INFORMATION

Requests for copies of this package should be directed to 1-800-313-3774.

Electric Power Research Institute and EPRI are registered service marks of the
Electric Power Research Institute, Inc. EPRI. POWERING PROGRESS is a service

mark of the Electric Power Research Institute, Inc.

Copyright © 1996 - 2001 Electric Power Research Institute, Inc. All rights reserved.

v



PREFACE

EPRI Area Investment Strategy Model: A Utility
Perspective

Recognizing the need to establish a business case outlook toward distribution system
investments, Wisconsin Electric has been actively involved in the EPRI project to
produce a PC-based Area Investment Strategy Model. Version 1.6 is the third
commercial version of that model. This perspective provides an overview of the
model and suggests how the model might be used.

Model Overview

The Area Investment Strategy Model directly addresses the issue of minimizing the
cost of providing reliable distribution system capacity in the face of uncertain load
growth. The question of larger versus smaller capacity additions has always been
considered by the distribution planner in seeking that plan which most closely tracks
the need, and is thus most economical. Often, several load growth trends have been
evaluated to test the sensitivity of a plan to different load conditions. That approach,
however, examines only smooth trends and not the discontinuous changes in growth
that will be potentially experienced in a particular area of the distribution system over
time. This new model explicitly recognizes random yet related changes in load
growth trend and provides a better means of comparing large versus small increments
of capacity.

This new model does not change the basic distribution planning process, but rather
augments that process by allowing further insights to be gained into the robustness of
a plan. The planner determines area capacity and capacity problems, including
thermal, voltage, and reliability, as usual, and then constructs capacity addition plans
that meet the identified needs. If the planner wishes to use the model to compare
several plans, certain inputs related to 1) the load growth characteristics of the area
and 2) the characteristics of the specific capacity additions must be determined.



The load growth characteristics are placed in a matrix which defines several growth
rates, usually the expected rate and a low and high limit, and the probabilities of
staying in each of these rates or transitioning to one of the other rates. There is a
procedure and spreadsheet available to help the planner assess these parameters.

The characteristics of specific capacity additions include the amount of capacity,
capital cost, operating costs, and impact of the capacity additions on losses and
customer value of unserved energy. These capacity additions can easily include
distributed resources. A scenario with only the costs of losses and unserved energy
may be constructed to capture the most likely impact of making no improvements in
an area. Capacity additions can be easily constrained to follow a certain installation
order or to be mutually exclusive, if the planner’s judgment deems this to be more
realistic.

The model can typically be run in less than one minute. It first quickly determines a
tree structure that defines all possible load paths and then fits capacity additions to
those paths in order to find the most economical strategy of meeting any given load
trajectory. This optimum strategy is output along with supporting information. It is
possible to view other paths to ascertain the robustness of the optimum strategy and it
is possible to easily change parameters to test the sensitivity of the optimal strategy to
changes in the parameters.

The Version 1.6 User’s Manual is a complete description of the Area Investment
Strategy Model.

Suggestions for Model Use

The model is best applied in those situations where the installed cost of the larger
capacity items exceeds $50/kW or the initial utilization cost (installation cost divided
by the load placed on the facility in the year of installation) exceeds $100/kW. This
would tend to exclude a new package substation located under an existing
transmission circuit and feeding into an existing distribution infrastructure. The need
for a new substation with a lengthy transmission supply or one located in a highly
urbanized setting would provide a likely candidate. Of course, the judgment of the
planner or the existence of special circumstances, such as anticipated public
opposition to a project or a system area that is well suited to a distributed resource
solution, should govern application of the model. The dollar limits cited are intended
only as a rough guide. Use of the model in examining plans will provide valuable
insights into whether a large investment in distribution capacity is wise at a given
point in time or, if instead, a small increment should be added now and further
additions made contingent on actual growth.

Paul Freischmidt
Wisconsin Electric
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CHAPTER 1 INTRODUCTION

1.1 Installing the M odel

The accompanying CD disk contain the setup program that will install the model. The
system requirements for the model are:

Windows 95 or a more recent version of Windows,
5mb of RAM,

8mb of free space on ahard drive,

Acrobat Reader 4.0 installed on the host machine.

Acrobat reader is used by the model to display the help file. If the user does not have
the software they can download it for free from Adobe' s website (www.adobe.com).

To install the model insert the disk in the CD-ROM drive. If the setup program does
not start automatically, click START, select Run, enter D:\SETUP in the dialog box
and click OK (if D: isnot the drive identifier for the CD-ROM, enter the appropriate
driveidentifier). Then, follow the directions on the screen to compl ete the setup.

Unless the user specifies otherwise during installation, the program and case files are
placed in the c:\Program Files\EPRI\Areal nvest directory. The DLL files are placed
in the c:\windows\system directory.

Note: Four example data sets are provided with the software. Theinput files are
casel.aip, case2.aip, and real_case.aip. The outputs have the same names but with
extension .Report (outputs are stored in a sub-directory labeled Sample Outputs).
Thereisalso aninput data set for the Load Assessor tool. The example |oad assessor
files are assessor.drs and assessorJump.drs. These data sets are the inputs used for
the tutorial in CHAPTER 4 and the “Real Utility Example” in CHAPTER 5.



Learning To Use The Model

If the user wants to verify that the model is correctly installed and working, he or she
can run each of the four cases (using the files with extension .aip) and compare the
resulting output files with the outputs stored in the sub-directory Sample Outputs. To
do this the user should:

1) Open the program by clicking START, selecting Program, and
highlighting the Area I nvestment Strategy program, and double-clicking
the light bulb icon.

2) Loadacase. Todo this, open the File menu and open one of the sample
cases supplied, which have the extension .aip, by selecting Open Case.

3) Runacase. To do thisopenthe Analysis menu and select Run and click
RUN when the dialog box appears. Successful execution of the case
occurs when a cost summary report appears.

4) Compare the resulting output files with the appropriate output filesin the
subdirectory Sample Outputs.

NOTE: The user should NEVER open a new input file and attempt to run the
case using default values (by opening the File menu and selecting New Case). In
addition, thefirst time user should NEVER attempt to build a case from scratch.
Users should usethe data sets distributed with the softwar e as templates for
constructing inputs. There aretwo reasons:

First, building an input data set from scratch requires a good understanding of both the
analysis methodology and the functionality of the software. Developing this
understanding requires, at a minimum, working through and studying the tutorialsin
CHAPTER 4 and CHAPTER 5.

The default values in anew data set are not valid datainputs. If the user attemptsto
run the model with these inputs, the model will return data error messages and the
model will not run. The decision to not provide a valid default data was part of the
software design. To correctly analyze infrastructure strategy options, utility analysts
should think carefully about how to structure their problems and about the inputs that
are appropriate given their specific problems. Providing a default data set would not
encourage the necessary thinking.

1.2 Learning To Use The Model

The Area Investment Strategy Model is designed to help utilities solve distribution
infrastructure planning problems. Successful application of the model requires



CHAPTER 1 INTRODUCTION

learning not only how to enter data and run the model but also requires some
understanding of the analysis methodology behind the software

Before attempting to use the model to solve real utility problems, the user should work
through the step-by-step tutorial in CHAPTER 4. To successfully complete the
tutorial, the user must EXACTLY follow the steps described in CHAPTER 4. The
tutorial is designed to help the user begin to understand the functionality of the model
and the analytical methods that underlie the model.

After completing the tutorial, CHAPTER 4, we recommend that the user work
through the real case application described in CHAPTER 5. This chapter, like the
CHAPTER 4 tutorial, provides a set of step-by-step instructions that illustrate an
investment analysis. After completing CHAPTER 4 and CHAPTER 5 the user should
be ready to begin to apply the model to their specific investment problems.

1.3 Error Traps

The software traps most data inconsistencies at the user interface level. However,
there are certain situations where error conditions are recognized only after the model
is processing the data. In order to ensure robustness of the software, the software
traps run-time generated errors and reports it back to the user in aWindow as a RUN-
TIME ERROR. When this happens the user is asked click OK, the model returns to
the main window.

In some (hopefully rare!) instances, the error message is one that should not have
occurred and. occurs only because of an internal inconsistency in the software. Inthis
case, the names and phone numbers of contacts at EPRI and Stanford Business
Software, Inc. (SBSI) will be displayed. Please contact at least one of them with the
exact message as it appears on your screen.

In other situations, the error message will point you in the right direction and you can
attempt to modify the data for the case and re-run the model (after restarting the
software). However, in this case too, should the message be unclear or if you have
any questions, please do not hesitate to contact EPRI or SBSI.

If the model detects that there is not enough capacity to meet capacity needs under all
potential load growth trajectories; it reports an error because then there is no feasible
solution. Y ou can get past this error in four ways: a.) adding additional alternatives,
b.) decreasing load growth, c.) decreasing the planning horizon, or d.) modifying the
constraints. Ideally, the model should automatically handle this situation and report a
warning. However, such a schemeis not as simple asit sounds and we are attempting
to find a good solution for afuture release of the model.
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1.4 What's New

Severa new features and enhancements have been added to the model since the
release of Version 1.0.

1)

2)

3)

4)

5)

A Do Nothing investment option has been added. Do Nothing is used to
represent the decision to delay any capacity additions until a given
amount of load growth has occurred. See the “ Capacity Alternatives’
section in CHAPTER 2.

Band-Aids can be salvageable or not. This allows for better modeling of
investments that can be removed and reused. Portable substations and
distributed generators are examples of potentially salvageable
investments.. See the “ Capacity Alternatives’ section in CHAPTER 2.

A load uncertainty assessment tool has been added to the model. This
tool facilitates development of the required load-growth input parameters.
For a description see section 2.4, Using The Load Assessor Tool.

The speed of the load forecasting a gorithm has been increased
dramatically.

There are additional output reports and an improved user interface.

1.5 Contacting Us

TO REPORT PROBLEMS AND GET HELP RUNNING THE MODEL CONTACT
EPRI USER SUPPORT:

1 The EPRI project manager
Steve Chapel
(650) 855-2608
schapel @epri.com

2. The Software devel oper
Mukund Thapa
Stanford Business Software
(650) 967-6998
mukund@sbsinc.net




CHAPTER 2 MODEL USER’S
GUIDE

2.1 Introduction

This User's Guide for the Area Investment Strategy Model describes the user interface
and the way inputs and outputs are handled by the interface. The user interfaceisa
standard Windows implementation. It waswritten in Visual Basic. Because of the
Windows implementation, users should be able to edit data sets, run the model and
view results with little or no reference to this User Guide. However the modeling
process requires considerable thought and it is highly recommended that model users
carefully study the methodology in the rest of this User's Manual.

2.2 Running The Model

Open the model by clicking START, selecting Program, and highlighting the Area
Investment Strategy program, and double-clicking the light bulb icon.

When the model is started, a start-up window is displayed for about ten seconds. This
screen has the name of the program, the version number, and the list of individuals
that developed the program. If you want to close the screen before it automatically
closes, double click on the light bulb in the middle of the screen.

Once the opening screen disappears, the model displays a dialog box asking if you
want to work on anew case or an existing case. If you want to work on an existing
case, you must select the case. If you choose not to create a new case or work on an
existing case, you can later make the selection through the File menu option.

Following this, the main window for the program is displayed through whose menu
system you can edit files, save files, run the model and view results. Thiswindow is
shown below in Figure 2.1.



Running The Model

% Area Investment Strategy Model: C:' Program Files', EPRISkrategy'real - |EI|£|

File Edit Analysis ‘Window Help

Figure2.1 Main Screen

It would be agood ideato verify the correctness of your installation now. To do this
open the File menu and open one of the sample cases supplied, which have the
extension ".aip." Open the Analysis menu and run acase. Successful execution of the
case occurs when a cost summary report appears; in this case, the model has been
correctly installed.
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2.3 Using the Strategy Model User Interface

23.1 TheFileMenu

Thefile menu is used to create, open, and save input data sets. This menu is shownin
Figure 2.2. The file menu has five options, which are described next.

% Area Investment Strategy Model: C:Program Files,EPRI'Strateqg ]
,ﬁ Edit Analysis Window Help

MNew Case Chrl+r

Open Case Chrl+0

Save Case Chrl+5
Save Case s ChrH+a

Exit

Figure2.2 FileMenu
New Case

Selecting this causes the program to clear all data and let the user enter a new set of
data. If acaseisbeing worked on, the user is given an option to save the current data
if any of the values have changed.

NOTE: The user should NEVER open a hew input file and attempt to run the
case using default values (by opening the File menu and selecting New Case). In
addition, thefirst time user should NEVER attempt to build a case from scratch.
User s should use the data sets distributed with the softwar e as templates for
constructing inputs.
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Open Case

Selecting this causes the program to prompt the user for an existing case through the
standard Windows open dialog box. If acaseis being worked on, the user is given an
option to save the current dataif any of the values have changed.

Save

Savesthe case datato disk. If itisanew casethe user is asked to select a name and
location through a standard Windows file save dialog box.

Save As

Saves the case data to disk under a user-specified name and location. The user is
asked to select a name and location through a standard Windows file save dial og box.

Exit

Exits the program. If the case data has changed and not been saved, the user is
prompted for confirmation.

2.3.2 Editing Data Sets

The Edit menu is used to edit both new and existing data sets. Here we outline the
different user data entry options.

Section 3.2 (Model Description), summarizes the input data requirements for the
investment strategy model. In addition, CHAPTER 1 contains the technical
documentation. The user should review both of these sections to gain familiarity with
the methodology that underlies the model. To use the model effectively, the user will
need to study CHAPTER 1 and 5in detail. That study is probably best donein the
context of doing a company-specific analysis.

Figure 2.3 shows the itemsin the edit menu.
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% Area Investment Strateqy Model: C:5Program Files\EPRI'Skrateq - |D|ﬂ

Filz | Edit Anakysis  window Help

Case Title and Descripkion

Basic Planning Data

Load Growth Specifications
Load Shape

Capacity Alternatives

Operating Costs

Losses and Unserved Energy ¥
Inskallation Constraints

Terminal Yalue

Advanced User

Figure2.3 Edit Menu Items

Selecting an item in the Edit menu brings up a data dialog box. Selected dialog boxes
are shown below along with brief explanations of input parameters.

Operational Features of the Editing Interface

Some of the input forms are interrelated. For example the number of capacity
aternatives entered in the Capacity Alternatives form determines the number of rows
in the Operating Cost form. Because of this, the user interface will not allow certain
forms to be open at the same time.

Theinput forms are designed so that the user can tab from one data field to another.
The one exception is grid inputs. Tabs can be used to move between cellswithin a
grid but atab cannot be used to exit the grid.

All grids can be edited by selecting a cell in the grid and hitting F2. Thisis a standard

feature of the windows interface. Thus, if you want to edit exiting datain agrid, you
can use the F2 function key.

Case Titleand Description

Figure 2.4 shows the form used to input the case title and description. Note all input
screens use data from the “real utility” example presented in CHAPTER 5.
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% Area Investment Strategy Model: C:% Program Files . EPRIStrategy’real ca - |EI|£|
File Edit Analysis ‘Window Help

-l
Case Title
|F|ea| UtilityTest Caze
Description:
Bagze Caze - with non-zalvagale engines. ﬂ
* CLEAR
+ OK
j X Q.AN[ZE!
Figure2.4 CaseTitleand Description
Input Explanation
CaseTitle A name for the case (40 characters or less) — appears on all of
the output forms.
Description A description of the case.

Basic Planning Data

Figure 2.5 shows the basic data input form. Note that the discount rateisin "real”
terms (the effects of inflation should not be included in the discount rate parameter).
CHAPTER 6, Section 6.4, describes the accounting methods.

10
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% Area Investment Strategy Model: C:' Program Files', EPRISkrategy'real - |EI|£|
File Edit Analysis  Window  Help
ﬂ
Time Interval for Decisions [Years: 1 -- 30] ||-|2
Dizcount Rate (0.0001 -- 1.0) ID-DE??
Inflation Rate [0.0 --1.0] ID_D4
Tax Rate (0.0 - 1.0) IU

f* Before Tax Cazh Flow

Accounting Method
|7("' After Taw Cazh Flow

x Qancel| J DOk |

Figure 2.5 Basc Planning Data

Input

Explanation

Time Interval for

The time interval over which the decisions and uncertainties are

Decisions modeled in detail.

Discount Rate The discount used for calculating present values. Thisrateis
“real” and thus should not include the effects of inflation.

Inflation Rate The general inflation rate assumed for the study. This defines
the basis for escalating costs.

Tax Rate Thisisthe overal corporate tax rate used when applying the

after tax cash flow method. The user should read CHAPTER 6
Section 6.4 for technical details. It isrecommended that a
default of .34 be used - the federal tax rate for large
corporations.

11
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Accounting Method | The user must select either the Before Tax Method or the After
Tax Method. This determines whether cash flows are
calculated on a before tax or after tax basis. If the after tax
method is chosen, the user should specify the depreciation
schedule in the Capacity Alternatives screen.

Note: The Strategy Model uses real cash flows for economic calculations. The
equation that underlies all Strategy Model present values calculationsis:

PV =3 CF (1L+ESC)'/[ (1+RDR) (1+ INF) |'

Where PV is present value, CF; isthe cash flow in year t measured in year t=0 dollars,
ESC is the escalation on the cash flow component, RDF isthe real discount rate, and
INF istheinflation rate.

Load Growth Specifications

Figure 2.6 isthe form used to record load growth specifications. The user should read
the "Modeling Load Uncertainty" section in CHAPTER 6 before entering data here.
The load modeling approach is based on the ideathat it is useful to describe load
growth in terms of multiple growth trends that persist for uncertain durations. The
model requires arelatively small number of input variables. The user must specify 1)
information on load growth trends (growth rates and trend-to-trend transition
probabilities), 2) the initial load condition, and 3) load saturation parameters.

12




# Area Investment Strategy Model: C:'Program Files'EPRI' Strategy'real_case - |EI|5|

File Edit Analysis ‘Window Help

CHAPTER 2 MODEL USER SGUIDE

i
Mumber of Load Growth Rates: |3_ » Qancel| J Ok |
GrowthRate | LO Prob | ME Prob | HI Prob | Trend
LO 1.01 0.75 0.25 0Lo
ME 1.0201 0.125 0.75 0.125 ME
HI 1.051 0 0.25 0.75 HI

Initial Load [kW):

Initial Load Growth Rate  [1.01 Saturation Onset Load (k'] |suunu
ASSESS LOAD GROWTH PROBABILITIES | LT G0 e 1452 [70000

|44EDB ¥ Include Saturation Effect

Figure 2.6 Load Growth Specifications

Input

Explanation

Number of Load

Load growth uncertainty is modeled using up to five load

Growth Rates growth trends. In the example input form above there are
three growth trends.

Growth Rate For each load growth trend there is an annual growth factor,
expressed in decimalsas (1 + annual load growth rate).

Transition In the example input form above, the rows in the matrix are

Probabilities the probabilities of jumping to each of the growth trends (LO,

ME and HI) for the next year, conditional on the current trend.
Think of the rows as “from” and the columns as “to.” An
assessment tool designed to help the user devel op these input
probabilitiesisincluded with the software. Thetool is
activated by clicking the “ASSESS LOAD GROWTH
PROBABILITIESBUTTON.

13
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Trend These are user inputs used to label each of the growth trends
(LO, ME, and HI for the example shown in above.
Initial Load The peak load in kilowatts at the start of the planning period.

Initial Load Growth
Rate

The growth at the start of the planning period. Thisinput
cannot be lower than the lowest growth trend or higher than
the highest growth trend.

Include Saturation
Effect

If this box is checked, load in the areawill be constrained by
the model to not exceed the maximum areaload (the
saturation level). If the box is checked, the user must specify
the two additional inputs listed below.

Saturation Onset
Load (kW)

Peak loads above thislevel grow progressively more slowly
and approach the maximum area load asymptotically

Maximum Area

The maximum level that load can grow to in the area -- the

Load (kW) load saturation level.

Assess Load If the user clicks this button an add-in assessment tool is

Growth activated (Load Assessor). Thistool requires that the user

Probabilities answer a set of questions concerning current load level and
growth, and future load growth scenarios. Based on the
answers, the tool estimates the inputs for the growth trends
and transition probabilities. See Section 2.4, for adescription
of the Load Assessor Maodel, including the input and output
screens.

L oad Shape

The Annual Load Duration Curve is entered using the Load Shape form - Figure 2.7.
Thisinput is explained in the "Model Description" sectionin CHAPTER 3

14
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# Area Investment Strategy Model: C:'Program Files'EPRI'Strategy'real_case.a - |EI|5|
File Edit Analysis ‘Window Help
% Load Shape -0l x|
Number of Points (2 to 20)  [§ Ok | X Cancel

Mote: Specify the load duration as a percent of peak load over 8760 houwrs

Time (hrs) | Load as % of Peak
0 0 100
1 & 55
? 264 90
3 f755 25
4 &760 0
Figure 2.7 Load Shape
Input Explanation

Number of Points

Thisisthe number of points used to specify the load duration
curve. The curveisforced to pass through the two points (0,
100%) and (8760, 0%). The user can specify intermediate
points. If none are specified, the load duration curveis
assumed to be atriangle.

Time and Hours

These are pairs of time and greater-than-or-equal -to-
probability points: for example in Figure 2.7, load is > 95% of
peak load for 88 hours.

Capacity Alternatives

Capacity alternatives, capital costs, escalation, lead-times and depreciation schedule
are entered using the Capacity Alternatives form - Figure 2.8.

15
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% Area Investment Strategy Model: C:'Program Files'EPRI Strategy'ireal ¢

File Edit Analysis Window Help

=10lx]

-0l
+ Add | ¥ Delete| X Cancel| Jok |

Name Type Category =

2 |F Strateaic > ||l oad following x

i |E1 Band Aid __ ~||Non load followina -

1 |E2 Band Aid __ ~||Non load followina -

5 |E3 Band Aid __ ~||Non load followina -

6 |E4 Band Aid  ~||Non load following ~|__|

Are All Band Aids Salvageable? [ies

Figure 2.8 Capacity Alternatives

Input

Explanation

Name

A name used to label specific capacity alternatives. For
example, Sand Fin Figure 2.8 are used to represent a
substation and a feeder.

Type

The user must select one of three types of alternatives:
Srategic, Bandaid or Do Nothing. Strategic is used to
represent major capacity additions, such as substations.
Bandaid is used to represent smaller alternatives such as
capacitors, distributed resources and DSM programs. Do
Nothing is used to represent the decision to delay any capacity
additions until a given amount of load growth has occurred.

Bandaid dternatives (B1, B2, B3, and B4 in Figure 2.8 are
constrained to be installed in the sequence that they appear in
theinput form. There are only two numerical inputs
associated with Do Nothing: (1) the capacity which defines
the amount of the delay, and (2) variable O&M (see the
operating cost screen, Figure 2.9). For Do Nothing, variable
O&M isused to define the cost of unserved energy.

Category

The user must select one of four alternatives: Load Following,
Non-Load Following, Load Following DSM, or Non-L oad

16
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Following DSM. This parameter is used for operating cost
calculations. See Section 6.7 for an explanation of the
operating cost calculations.

Capacity (kW)

The peak capacity (in kilowatts) added by the alternative.

Capital ($000)

The current year capital cost in thousands of dollars.

Cost Escalation

Thisis an escalation factor relative to the rate of inflation. A
value of 1.0 means that the cost of the alternative escalates at
the rate of inflation. Valueslessthan 1.0 mean that the
escalation is less than the rate of inflation. The factor must be
in the range 0.01 to 2.0.

Lead Time (yrs.)

Thisisthetime in years between making the decision to invest
in an alternative and the time at which it is placed in service.
Lead times can be caused by such things as licensing, siting
delays and construction times.

Life (yrs.) Thisisthe physical life of the asset (between 1 and 50 years).
Depreciation This should be specified when the user wishes to select the
Schedule after tax cash flow accounting method. Clicking on this box
activates an input screen with four alternatives: NONE,
Straight Line, MACRS15, and User Defined. See CHAPTER
6, Section 6.4 for details on modeling after-tax cash flows.
Description A user-provided description of the capacity alternative.

Are All Band Aids
Salvageable

The user must select yesor no. Thisalows for removal and
reuse of some types of investments such as distributed
generation. If atechnology will never be removed and reused,
the user should select no. See CHAPTER 6 Section 6.6 for
technical details.

Note: We repeat a previous warning. If the model detects that there is not enough
capacity to meet capacity needs under all potential load growth trajectories, it
reports an error because then there is no feasible solution. Y ou can get past this
error in four ways: 1) adding additional alternatives, 2) decreasing load growth,
3) decreasing the planning horizon, or 4) modifying the constraints.

17
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Operating Costs

Operating cost parametersinclude fixed O& M, fuel, heat rate, variable O&M, and
system-energy costs. Operating cost inputs are entered using the Operating Cost form
shown in Figure 2.9. Note that system energy costs are defined as costs avoided by
the operation of local generation or DSM programs. For traditional T&D options,
avoided system energy costs should be zero.

Using the form shown in Figure 2.9, the user can also enter emission costs associated
with each of the capacity alternatives. Entering emissions costsis straightforward. It
isdone by clicking on the emissions tab and filling in the form. The form alows
entries for NOX, SOX, CO2, and other. Emissions are entered in tons per kwh and
the cost of emissionsin dollars per ton.

% Area Investment Strategy Model: C:\Program Files,EPRIY Strategyireal_case

File Edit Analysis ‘window Help

=10] x|

+ D0k

% Operating Costs

| » Qancel|

]

0 M Costs % Emission Costs

Fixed O&M ($000/yr) | Fuel ($MMBTU) |Heat Rate ibtu/kwh) | Var

S 100 0

F B0 0

E1 40 0

E2 50 0

E3 g0 1]

Ed 1] 0
< |

0

oo o oo
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Input Explanation
Fixed O&M Fixed operations and mai ntenance costs in thousands of
($000/yr.) dollars.

Fuel (SMMBtu)

Fuel costsin dollars per million Btu (for aternatives that use
fuel).

Heat Rate Heat rate for capacity alternatives that use fuel (in Btu per

(Btu/kwh) kWh).

Variable O&M Variable operations and maintenance costs (in dollars per

($/kWh) kWh). Note that for traditional T&D options, such as circuits
and substations, the user should include the cost of energy
from the bulk system.

System Avoided Avoided system energy costsin dollars per kWh. If the user

Cost $’kWh) inputs a value greater than zero, the model treats the

technology as NOT load following. If zero is entered, the
model treats the technology as load following. Thus zero
should be entered for all load-following devices (such as
circuits, and substations). See CHAPTER 6, Section 6.7 for
details.

L osses and Unserved Energy

L osses and unserved energy are input using the Losses and Unserved energy forms.
The user should read Section 6.8 for a detailed explanation of these inputs. The input
forms are shown in Figure 2.10 and Figure 2.11.
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% Area Investment Strategy Model: C:' Program Files) EPRI'Strategy'ir 101 =l

File Edit Analysis  Window Help

% Losses And Unserved Energy For Strategic Alternatives - |D|ﬂ

+J/ Ok | 4 Qancel|

Number of Points (0 to 20) IhD

Strategic Alternative: |5 vl

Load (Kw) | Losses ($000) | Unserved Energy ($000)
1 44608 76 1
2 45724 79 1
3 46867 B3 1
4 48033 87 1
5 497739 91 2
6 50470 95 2
7 51732 99 3
8 53025 104 4
9 54351 110 ]
10 85710 115 B

Mote: The number of rows and the load values are the same for all

Figure2.10 Lossesand Unserved Energy for Strategic Alternatives

These inputs allow users to associate the dollar value of losses and unserved energy
with operating at specific load levels with specific technologies in the infrastructure
technology mix. The default values for these inputs are zero. Thus, if these costs are
zero for a particular study, the user does not need to provide the inputs.

Input Explanation
Number of Points The number of load levels at which losses and unserved

energy needs to be specified. This number defines the
number of rows in the losses and unserved energy table.
This number of rows will be used for all strategic
alternatives where losses and unserved energy inputs are
specified.

20
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Strategic Alternative

The user can specify losses and unserved energy for each of
their strategic alternatives. For each table of inputs, the user
must select one of their strategic alternatives from the drop-
down menu. Once selected the table of losses and unserved
energy can befilled in. Thetable of losses and unserved
energy apply when that alternative is part of the technology
mix. In addition to user-specified strategic aternatives,
thereisthe “Do Nothing” alternative. If the user selects this
alternative, the losses and unserved energy costs are applied
in the case where none of the specified strategic alternatives
arein the technology mix.

Load (kW) The kilowatt load level for each row in the losses and
unserved energy matrix.
L osses ($000) The dollar value associated with the energy losses given the

load level for each row (in thousands of dollars).

% Area Investment Strategy Model: C:' Program FilesiEPRILS - |EI|5|

File Edit Analvsis ‘Window Help

% Loss/Unserved Energy Reduction by Bandaids - |EI|5|

+J Ok | 4 Eancel|

4| v/ Coss Reduction(%) % Unserved Energy Redn (9 %,
Pre 3 | F
E1 1] 1] 1
E2 1] 1] 1
E3 1] 1] 27
E4 1] 1] 27

Figure 2.11 Losses and Unserved Energy Reduction by Band-Aids
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Unserved Energy The dollars associated with unserved energy, given the load

($000) level for each row (in thousands of dollars)..

Input Explanation

Loss Reduction (%) | The percent reduction in the cost of losses. This can be
specified for bandaid installations prior to any of the strategic
aternatives (“Pre” column) and for installations with each of
the strategic aternatives. The user can provide values for each
bandaid alternative. Default values are zero. Note that the
values are cumulative.

Unserved Energy The percent reduction in the cost of unserved energy. Thiscan

Reduction (%) be specified for bandaid installations prior to any of the

strategic alternatives and for installations with each of the
strategic alternatives. The user can provide values for each
bandaid alternative. Default values are zero.

Installation Constraints

A key feature of the strategy model is the ability to place constraints on the number
and ordering of the capacity alternatives. Thisisillustrated in the Installation
Constraints form - Figure 2.12. In this data set, there can only be one S (substation),
one F (feeder), and the feeder cannot follow the substation.

% Area Investment Strategy Model: C:' Program Files'EPRI'Strategy’,re. - | Ellll

File Edit Analysis Wwindow Help

1ol
+add | IO Edit | % Delete] X Cancel| Ok |

1  |Mumber of S must be <=1

Murnber of F must be <=1
3 |F cannot follow 5
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Aninput form alows installation constraints to be added, edited and deleted. Figure
2.13 illustrates the form used for specifying constraints. On the |eft side of the form
the user must select a capacity aternative that will appear on the left side of the
constraint condition. The middle of the form contains the set of constraint conditions
that can be selected. On the right side the user can set quantitative limits on the
number of occurrences of specific alternatives. The user can also use the drop-down
menu on the right side of the form to select one or more capacity alternatives in order
to apply precedence constraints (for example, F cannot follow S)

onstraint Specification

zt be lezz than or equal to

anhot ocour together with the zelected alernatives

muzt be preceded by all of the zelected alternatives

muzt be preceded by at leazt one aof the zelected alkermatives
annot follow any one of the selected altematives

Figure 2.13 Specifying Installation Constraints
Terminal Value

Two options are alowed for terminal value. These are selected using the Terminal
Valueform. Thisinput datais explained in Section 6.2: "Modeling Planning Period
End-Effects.”

Thefirst option, terminal lottery on capacity price, assumesthat al capacity added
during the planning study is sold at the end of the planning period. The salepriceis
determined by the remaining life of the asset and the input variable Price of Capacity
at Terminal Time. The second option, Cost-to-Go, assumes that the assets are kept
until they reach the end of their life and then replaced with new assets. The cost of the
new assets isthe input variable Price of Capacity at Terminal Time.

Theinput formis Figure 2.14.
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% Area Investment Strategy Model: C:'Program Files'EPRIStrategy'ireal cas ;|g|1|
File Edit Analysis Window Help
x
Terminal Value Option
{+ Terminal Lottery on Capacity Price: M
' Cost-to-Go X Cancel
Price of Capacity at the Terminal Time [$/kw-yr] Im—
Figure 2.14 Terminal Value
Input Explanation
Terminal Value Select either Terminal Lottery on Capacity Price or Cost-to-Go.
Option The User should read Section 6.2 for technical details.
The second option, Cost-To-Go, should not be selected unless
the user is an expert model user and has discussed the details of
this option with the EPRI project manager Steve Chapel.
Price of Capacity at | Specify the cost per kW-yr. of buying capacity at the end of the

Termina Time

planning period. This should be in current year dollars (dollars
as measured in year 0 of the planning study).

Escalation on Price
of Capacity

Thisis an escalation factor relative to the rate of inflation. A
value of 1 meansthat the price escalates at the rate of inflation.
Values |less than 1 mean that the escalation is less than the rate
of inflation. The factor must be in the range .01 to 2.
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Operating Cost of Thisisthe average operating costs for all capacity purchased
Capacity ($/kwWh) after the end of the planning period. This should be in current
year dollars (dollars as measured in year 0 of the planning

study).
Escalation on Thisis an escalation factor relative to the rate of inflation. A
Operating Cost value of 1 meansthat the cost escalates at the rate of inflation.

Values less than 1 mean that the escalation is less than the rate
of inflation. The factor must be in the range .01 to 2.

Final Load Growth | Thisisthelong term average load growth for the area. Thisis
Rate the rate that is expected to occur after the end of the planning
period. The allowed rangeis 1.00001 to 1.5.

Advanced User

Thefinal input formis Advanced User - Figure 2.15. This form controls the number
of nodes (between 50,000 and 9,999,999) allowed in the decision tree and the
coalescence option. These options determine the size of the problem that the model
will solve, the speed of execution, and have some effect on numerical results.

Exercising the coalescence option can dramatically improve the run time for large
problems (it can actually increase the run time for small problems) but the method is
an approximation and can have some effect on the numerical results. Because of this
is an approximation, the model is constrained to not allow coalescence before stage 5
of adecision tree. The user should contact EPRI user support for an explanation of
these options and their potential effects.
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% Area Investment Strategy Model: C:',Program Files\EPRIVSErategy'ireal _case.aip

File Edit Analysis Window Help

]

% Advanced User Options

+/ Ok | X Qancell

Mumnber of Modes [Including End Paintz] IEDDDD

Coalescence Option
&' Mone
" At Chance Mode

Figure 2.15 Advanced User

2.3.3 Running M odel and Viewing Results

The Analysis menu allows the user to run the model and view output reports. The
analysis menu is shown in Figure 2.16. The Analysis menu options are described

next.

% Area Investment Strategy Model: C:,Program Files'EPRI\SErategy'.real_case.aip

File Edit | Analysis ‘Window Help

=10 %]

Run |

Report  # Views
Delete

Figure 2.16 AnalysisMenu
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Run

If the user selects run form the Analysis menu, the model is run and the cursor
changesto an hourglass. As soon as the cal cul ations are complete a message box is
displayed followed by a summary output dialog box. This summary output is shown
below, Figure 2.17.

% Area Investment Strategy Model: C:,Program Files'\,EPRI'Strategy’.real _c -0 x]

File Edit Analysis Window Help

% COST SUMMARY (Area Investment Strategy Model) - |EI|5|

CASE MAME: Real UtilityTest Case

1st Year PV Cost Relative
Decision ($000) Costs
B 1625.22 100.00 LIk THEE
Z2 |F 233452 143.56
3 c 677 04 164 67 DECISION FREQUEMNCIES
BISK PROFILE
INPUT DATA
% FPrint
n Save
X Cloze

MOTE: The Strategy Model iz a "Strategic’ model, |tz designed to do a
good job of estimating the percentage differential costs among policies. 1t iz
not designed to forecast the absolute level of costs for any specific policy.

Figure 2.17 Summary Output

This dialog box shows present value of costs for the alternatives that could have been
used as the first year capacity decision. These are ordered from low cost to high cost.
Thefirst item in the table is the optimal (least cost) first year decision and isthe basis
for the optimal strategy. From thisform, the user can select four output reports.
These four additional reports can be viewed by clicking on the buttons on the
Summary Output window. The four reports are described bel ow.

Optimal Tree Report

If the user clicks on the button “ Optimal Tree” the least-cost decision strategy is
shown. Thisisillustrated in Figure 2.18. There are several tabs at the top of this
report. Thefirst tab, “Optimal Decisions,” shows only the investment decisions over
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time. The other tabs show greater detail on costs and load uncertainty. The
information contained the Optimal Tree Report is explained in greater detail in
CHAPTER 4 and CHAPTER 5, (ANALYSISTUTORIAL, and REAL UTILITY
EXAMPLE).

% Area Investment Strategy Model: C:Program Files'EPRISkrategy'ireal ca - |EI|1|
File Edit Analysis Window Help

| % DPTIMAL TREE (Area Investment Strategy Model) -0l .x|

CASE MAME: Real Utility T est Caze

4| » [/ OPTIMAL DECISIONS ' OPTIMAL TREE % CapitaliTerrminaliCperating Costs

Stage 1 Stage 2 | Stage 3 —[ Staged | Stage5 | S=

1 |Optimal Walue = 1626.22 =

2 |El E2 S -E2 -E1) Terminate

3 Terminate

4 Terminate

5 F{-E2-E1) 5 Terrminate

6 Terminate

7 Terminate

8 3 Terminate

9 Terrminate

10 Terminate

11 3 Terrminate

12 Terminate

13 Tetrminate -

&} Print | I save | X Close |

Figure 2.18 Optimal Tree

Decision Frequencies

Figure 2.19 shows the output report that results when the user selects “Decision
Frequencies.” This report shows for the years listed across the top, the proportion of
time that each investment optionisinstalled. For example:

1) attime0-1 option E1 ischosen,

2) attime 2-3 option F is chosen 17% of the time and no investment is made
83% of the time,

3) attime3-4, option Sis selected 6% of the time and no investment is made
the remaining 94%.
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Multiple possible investmentsin future years reflects the fact that load is uncertain
and can thus follow many possible growth trajectories. The Strategy Model
enumerates the possible trajectories and identifies the least expected-cost investments
conditional on current and future load growth.

% Area Investment Strategy Model: C:Program Files'EPRI'Strategy'real ca - |EI|1|
File Edit Analysis Window Help
-ipix
CASE MAME: Real UtilityTest Caze
Years = 0--1 [ 1-2 [ 2-3 [ 3-4 [ 4-5 | 5--6 | {
5 0.0617
F 0.1745 0.5511
E1 1.0000 0.2074
E2 0.4
E3
E4
| »
&} Print | [ Save | X Close

Figure 2.19 Decision Frequencies

Risk Profile

Figure 2.20 shows the output report that results when the user selects “Risk Profile.”
This report shows the probability distribution on cost outcomes for the least cost
investment policy. The first column gives cost-ranges and the second column give the
probability of occurrence of these cost-ranges.
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% Area Investment Strategy Model: C:'Program Files'EPRI Strategy'ireal ¢ - |EI|1|
File Edit Analysis Window Help
-iBx]
CASE MAME: Real UtilityTest Caze
Cost Range | Prohability =
1 16856.67 to  1713.64 0.1516 —
2 171364 to  1770.61 0.1329
3 177061 to 182758 0.0504
4 1827.58 to  1884.55 0.2571
b} 188455 to 194152 0.1198
6 194152 to 1998.50 0.0052
i 1995850 to 205547 0.0000
[i} 205547 to 2112.44 0.0000
9 211244 to 216941 0.0073
10 216941 to 222638 0.0000
11 202638 to 28335 0.0132
12 228335 to 234032 0.0305
13 234032 to 23597 .30 0.0211
14 239730 to 245427 0.0000
15 240427 to 2511.24 0.0337 -
E save | X Cloze
Figure 2.20 Risk Profile
Input Data

The final output report is obtained by clicking on the button labeled “Input Data.”
That report lists the user supplied inputs. The report is not shown here. The user can
print this report by selecting the print button. Dueto abuginaVisua Basic control,
the user should always select the option to print in portrait mode. If they select
landscape mode, datawill be lost. Asan alternative, the data can be copied into a
word processor document and printed.

Report

On selecting the report menu option you have two choices: view or delete.
If Report View is selected, a standard windows dialog box allows the user to select

output reports that were created by previous runs. All output reports have the form
"* Report". The user can also select Report Delete to delete existing report files.
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2.34 HELP Menu
The help menu items are described below.
Contents

If the user selects contents from the help menu, the contents of the on-line manual are
provided.

About

This provides copyright information and the version number of the model.
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2.4 Using The Load Assessor Tool

24.1 I ntroduction

L oad Assessor is designed to provide estimates of the load growth trends and the
transition probabilities required by the Investment Strategy Model — the inputs shown
in Figure 2.6. The estimating methodol ogy requires data obtained from a set of
questions about future potential load conditions. The approach and question were
developed in collaboration with utility distribution planners. In developing the
specific questions, the objective has been to base the methodology on a practical set of
guestions that the model user’s can answer.

The purpose of the Load Assessor tool isto create a better base of load uncertainty
information for devel oping and evaluating investment strategies. Thetool provides
probabilistic information of future load conditions. Two factors motivated the
development of the approach for characterizing load uncertainty:

1) First, for distribution planning, akey issueis at what point in the future
will load growth result in agiven level of demand. This determinesthe
time to the next investment decision, since distribution capacity
requirements are based on load levels. Thus, a complete description of
potential load trajectories over timeisrequired in order to specify the time
to the next decision.

2) Second, load growth follows trends. For example, areaload typically
might grow at alow, steady rate for several years and then transition to
rapid growth for atime. This suggests that modeling future load
conditions should start with characterizing key parameters associated with
the possible trends -- the average duration’s of the trends, and the
likelihood's of shifting among the trends.

For amore detailed discussion of the load uncertainty methodol ogy see Section 6.5.
The user may also want to read the LoadDynamics™ User’s Manual.
LoadDynamics™ is a standalone load forecasting model that incorporates the same
load uncertainty methodology as the Area Investment Strategy Model. The Load
Assessor tool is aso built into the LoadDynamics™ M odel
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2.4.2 Using The Load Assessor User Interface

When the load assessor starts the window below (Figure 2.21) replaces the investment
strategy main window. The user must then use the File Menu to open a new or
existing case. All Load Assessor files are of the form *.drs. assessor.drsisthe
example case distributed with the software. Note that the File menu also allows the
user to save load assessor cases and to copy load assessor results directly to the
Strategy Model input screen, “Copy Results to Growth Scenarios.”

Note: The datain the input screens shown here are for the data file assessor.drs.

+ Area Investment Strategy Model: C:\Program Files\EPRIVArealnvestireal_case_aip
300 FILE Menu

[ Mew Load Azsezsment Data Chil+M
Open Previously Saved Assessment Data ... Chil+0
Sawe Loadissessment Mats [EtrliFS nty ASS essor
Savellean Gesessment ata fe [Etilire
Eopy Besults o) Grawth Scenanes... [t
Evit Load Agzeszment Process .. Chrl

Use The File Menu Te Open a New or Existing Case

Figure 2.21 L oad Assessor Main Screen
Home Screen

Assoon asacaseisopened, aseries of steps are listed in the home window along with
the status of completion for each step (To Do, Done, Data Error, Incomplete). Figure
2.22 shows the Home Screen for an existing case where al of the data have been
input, and the model parameters estimated. There are five stepsin the assessment
process:

1) Specify current load and growth

2) Specify load growth scenarios
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When a case is opened, new or existing, the status of datainputs are indicated on the
home screen. With anew case the user is constrained to proceed through the
assessment steps in sequence — the model will not allow skipping a step and valid data
must be provided for each step before the model will alow the user to go to the next
step. The assessment software performs error checking for each screen.

When the user is satisfied with their load assessor results they can 1) save the results,
and 2) copy the results to the Strategy Model “L oad Growth Specifications, input
form. Copying the datato Strategy Model inputs can be done via either the File menu

3) Specify growth rate holding times

4) Specify maximum areaload potential

5) Calculate load model parameters

or the button at the bottom of the home screen.

@ Load Assessor FILE Menu

=10l x|
=1=1x]

Load Uncertainty Assessor

TASK

Speciir Current L oad and Growlh

Specilis Luirent Growth Scensies

Snecilic Growlh Rale Helding Times

Specii Maximum Ares { oad Poleniial
CAL LA TE {oad Modef Parameiers

COPY RESULTS TO LOAD DYNAMICS

STATUS
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Specifying Current Load and Growth

The data screen for assessment step 1, Specify Current Load and Growth, is shown in
Figure 2.23. Here the user must specify current areaload and growth, and the time
interval for the forecast assessment.

[ LoadDynamics - [Screen 1 -- Specify Current Load, Current Growth, and Planning Period] - IEllél

=@l x|

Question 1: Current peak area load in kW (>0)? ||44l]l]l]
Question 2: Current area annual growth rate (0 to 202:)? |1
Question 3: Time interval for forecast (5 to 20 years)? |12

[ ate that in waur answer to Question 3. the time interval should be
long enough so that all significant future load changes are covered.

Figure2.23 Current Load & Growth
Specifying L oad Growth Sceanrios

The data screen for the second assessment step, Specify Load Growth Scenarios, is
shown in Figure 2.24. The purpose of the second screen isfor describing potential
future load growth scenarios. The basic ideais that the user must specify a set of
aternative growth conditions that could occur over the planning period.

Before filling in the data required by this form, the user should read the instructions
by pressing the Instructions button.
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[ LoadDynamics - [Screen 2 -- Specify Load Growth Scenarios] ;[glél
== x|
Task 1: Press button on right for instructions M
Task 2: Number of load growth scenarios(2 to 5)? |3 vl
Task 3: Using table. describe each scenario:
DES CRIPTION
Contmued low growth
Moderate trend
High trend
Task 4: Is there a possibility for periods of rapid growth - load jumps (¥ or N)? IK
Load Jump Data - Frequency and Rate
Fropartion of future years with rapid growth [0 > p <= .2]7 IW
W é ‘ Annual rate of growth for rapid growth years [%) Is—
Figure 2.24 L oad Growth Scenarios
The datainputs for the scenarios are the following:
Input Explanation
Number of The user must choose a number (2 to 5) from the drop-down
Scenarios box.
Label A short label used to describe each scenario.
Description A longer more descriptive characterization of each scenario.
Average Growth For each scenario the user must specify the average growth rate
Rate Over Period that is expected for the entire forecast period.
(%)
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Lowest Growth
Rate In Any Year
(%)

For each scenario the user must specify the lowest growth rate
that can occur in any year for the forecast period. This growth
rate must be lower than the average growth rate for the period.

Highest Growth
Rate In Any Year
(%)

For each scenario the user must specify the lowest highest
growth rate that can occur in any year for the forecast period.
This growth rate must be higher than the average rate for the
period.

Scenario For each scenario the user must specify the probability that the

Probability scenario will occur. The probabilities for the scenarios must
add to 1.0.

IsTherea If thereis apossibility of having short periods (one year or |ess)

Possibility For of rapid growth, enter Y.

Periods of Rapid

Growth?

Proportion of If the user specifies Y to the question Is there a possibility for

Future Years With | periods of rapid growth, they must indicate the proportion of

Rapid Growth future years where rapid growth is expected to occur (0to 0.2)

Annual Rate of If the user specifies 'Y to the question Is there a possibility for

Growth For Rapid | periods of rapid growth, they must indicate the associated

Growth Years annual percentage growth rate (this rate must be at |east twice

as large as the highest rate entered in the "highest growth rate
in any year" column of the Scenario Descriptions table).

Specifying Growth Rate Holding Times

The data screen for the third assessment step, Specify Growth Rate Holding Times, is
shown in Figure 2.25. Before entering any data, the user should click the Instructions
button and get specific information about the data inputs.

This screen shows three one-year growth rates and the user must supply “average
holding times for these rates. These rates come from user supplied inputs from the
previous screens — the minimum and maximum one-year rates from the scenario
inputs, and the current growth rate from the first input screen.
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% LoadDynamics - [Screen 3 - Specify Time in Load Growth Trends]

=1ol ]
=181x]

Task 1: Press button for instructions

Task 2: Enter an estimate of the average
number of years that each growth CR’:‘E]‘% Yﬁwwﬁtm
rate will persist (>= 1 year). CABEL _ o
Min Rate 0.5 mn
[Current 1 4
MaxRate |4 4
Task 3: Select load transition option. i~ Which iz More Likely?

Home <

Instructions

— Growth Rates

f* One Step Transition?

= Two or More Step transition?

Figure 2.25 Growth Rate Holding Times

The user must provide the following information:

Input

Explanation

Average Yearsin
the Rate

Thisiswhat we have termed “holding time.” Given that load is
growing at arate, thisisthe time that load is expected to
continue to grow at that rate. This measures the tendency for
load to stay in a particular growth trend.

Load Transition
Option

When load growth shifts from one trend to another, the user
must specify which of two conditionsis more likely. (1). A
transition of one trend-step versus, (2), atransition of two or
more trend-steps. For exampleisit more likely that load will
shift from alow rate to a medium rate or from low to a high
rate, bypassing the medium rate?
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Specifying Maximum Area L oad Potential

The data screen for the forth assessment step, Specify Maximum Area Potential Load,
isshown in Figure 2.26. Before entering any data, the user should click the
Instructions button and get specific information about the data inputs.

[# LoadDynamics - [Screen 4 - Specify Saturation Parameters]

=1olx]
=18(x]

Task 1: Press button for instructions Instructions

Task 2: Saturation: Maximum attainable area load (kW)? IBl]l]l]l]

Task 3: Saturation Onset (kw)? |5l]l]l]l]

hen a local area can absorb no further growth, itis said to saturate.
Saturation anset is the load lewel after which the load growth slows.

Home < -

Figure 2.26 Maximum Area Potential L oad

The user must provide the following information:

[nput Explanation

Maximum Thisisthe load level when the areais completely built-out. It
Attainable Area is when the area can absorb no further growth.

Load (kW)

Saturation Onset When saturation begins to occur, load growth beginsto slow.
Saturation onset isthe load level after which load growth
slows.
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Calculate Load Model Parameters

The data screen for the final assessment step, Calculate Load Model Parameters, is
shown in Figure 2.26. This screen shows the results after the Estimate Parameters
button has been clicked.

[# LoadDynamics - [Screen 5 - Calculating Load Model Parameters]

=Bl ]
=181x]

Estimate
Parameters

~ GROWTH RATES (%)

Input

Calc.

Growth Growth

Rate

Rate

05

0.5

225

202

4.

407

a.

AT

Instructions

From 1
Trend 2

Plot Results
~ TRANSITION PROBABILITIES
To Trend
1 2 3 4
071) 072 0312[ 005
0] 071 024 005
003 076) 071 005
015] 039] 046 i}

Home

<

Figure 2.27 Calculate Load Model Parameters

The functionality of the form for calculating the load model parametersis summarized

below:

Button Explanation

Estimate If this button is clicked, the estimation model is run to produce
Parameters anew set of growth trends and transition probabilities. If anew

or modified data exist in any of the screens, the transition
matrix will not be shown until the model is run.
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Plot Results If this button is clicked a plot of the probabilistic load forecast
isproduced. This plot isshown below -- Figure 2.28
Instructions This provides information on how the growth trends and

transition probabilities are estimated.

View Probabilistic Forecast

If the user clicks the Plot button in the Cal culate Parameters screen, the probabilistic

forecastisp

lotted. Thisisshownin Figure 2.28. For each year in the planning

period, the maximum, minimum and average load are plotted.

If thisload f

orecast does not accurately reflect the user’ s assessment of the possible

loads for the area, the Options button should be clicked. Clicking the Options button
brings up a dialog box with the following information:

1)

2)

3)

4)

If the upper bound on load is too high (low), then you should try reducing
(increasing) the average growth rate for the high growth scenario. Y ou
can also change the maximum possible load level, saturation level.

If the lower bound on load istoo low (high), then you should try
increasing (reducing) the average growth rate for the low growth scenario.

If the expected value for load is too high (low) then you can reduce
(increase) the probabilities for the higher growth scenarios and / or
increase (decrease) the probabilities for the lower growth scenarios. You
can also change the highest yearly growth rate for the high growth
scenario.

If load is growing too slowly (too rapidly), you should try increasing
(reducing) the highest yearly growth rate for the high growth scenario.

This completes Chapter 2, Model User’s Guide.
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[~ LoadDynamics - [Load Uncertainty]

605435

S911648

7365 4

556595

9393 3

522027

04742

48743 6

47017 A

43265 5

43360

Figure 2.28 Plot of Praobabilistic For ecast
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CHAPTER 3 BASIC
CONCEPTS

3.1 Introduction to Strategic Planning for
Distribution Investments

This section outlines the basic principles underlying strategic planning for distribution
infrastructure investments. The target audience for this section includes the planners
that operate the computer model and perform the analysis, the decision makers who
select and implement investment policies, and the regulators who review policies and
performance. For the Area Investment Strategy Model to be used effectively, all three
of these groups need to understand the basic principles.

Four subsections follow. The first subsection discusses the nature of the investment
strategy problem. The second subsection describes how the Area Investment Strategy
Model relates to more traditional capacity planning methods. The third subsection
describes the necessary reformulation the objective and the analysis methods The
forth subsection summarizes the analytical dimensions of the problem.

311 Thelnvestment Strategy Problem

Distribution assets comprise over 40 percent of total electric utility investment.
Although it would appear natural for distribution planning to focus on long-term
investment issues, at present a distribution planner's main objective is maximizing
system reliability within afixed budget. Distribution planning has traditionally
focused on meeting near-term customer demand by adding transformers and feeders.
Little attention is given to alternative technical solutions, the appropriate scale for
investments, or the long-term implications of resource commitments.

Maximizing reliability within afixed budget had been achieved through application of
planning criteriarules of thumb that minimize the effects of delivery problems and
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unexpected increases in demand (supply and demand disruptions). During normal
conditions, outages have not been acceptable. During disruptions (due to equipment
failures or rare high demand levels), application of the rules of thumb have limited the
outagesto afew hours per year.

This purely technical infrastructure planning approach was successful in a particular
business environment. That environment no longer exists. We note the following
changes:

e Industry restructuring, already under way, is bringing about the disaggregation of
the vertically integrated electric utility.

e For many companies, the funds allocated to the distribution side of the business
have been reduced. Distribution engineers are being forced to build business
cases around all significant projects.

o New customer needs, which vary by market segment, are beginning to emerge. In
particular, an increasing number of customers are demanding higher reliability
and improved power quality.

e Technology advances in information processing, communications, power
electronics, materials, and distributed generation are providing new distribution
investment options for meeting customer needs.

e Theindustry isincreasingly affected by uncertainties in load growth and resource
costs.

312 An Alternativeto Traditional Capacity Planning

As mentioned above, traditional electric distribution infrastructure planning addressed
short-term problems with installations having long-term implications. Responding to
thisimbalance, recent methods have taken alonger-term perspective, in which the
planner is asked to specify the future load growth and capacity plansin order to
determine the impact of deferring the plan using smaller, modular technologies
(distributed generation and load control programs). While this type of approach does
address one important piece of the problem — the long-term implications of large
investments — it neglects another, equally important, piece, which is the uncertainty
that accompanies any attempt to project more than ayear or two into the future.

The recent approaches are sometimes characterized as scenario planning because they

are based on one or afew selected snapshots or scenarios of the future in which all
future variables are assumed to be known and fixed over the planning period. Since
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the future is uncertain, this type of deterministic planning does not reflect the actual
utility decision environment and process. Thus, itisavery poor basis for developing
investment strategy.

In the scenario-planning approach, current investment alternatives are eval uated based
on their impact on some fixed future installation strategy. To define this strategy, the
planner must fully specify the type and installation dates of future T& D, generation,
and distributed resource investments. This, of course, requires specification of afixed
future load pattern over the planning horizon, which istypically 10 to 20 years long.
Current decisions are then compared with respect to how they affect the timing and
cash flow of the pre-specified installation strategy. For example, the decision to
install aprimary feeder at the beginning of the planning period is evaluated in terms of
itsimpact on delaying future capital investment in a substation.

Not only is the assumption of future certainty not realistic over any reasonable
planning horizon, but it places an artificial and uncomfortable burden on the planner.
We have found that planners are extremely reluctant to specify afuture investment
plan when they know that such a plan is only one of perhaps hundreds of future
realistic possibilities. The actual future investment plan will depend on how load
evolves and on the resolution of other uncertainties, such as siting constraints,
regulatory policies, environmental impacts and the structure of the business
environment.

In such situations, the decision process must be dynamic and responsive to change.
Good decision makers understand thiswell. They know that they must decide what to
do today, and as the future evolves, they will have to react to the changing situation
and make further decisions and commitments.

In order to be useful, planning models must capture the essence of the actual decision
environment and process. The Area Investment Strategy Model not only identifies
what action to take today, but also how to respond as key uncertainties evolve. The
approach reflects the dynamic nature of the actual decision process that adjusts
investment strategy when the future needs and costs are revealed. It simultaneously
determines the best policy and the cost of that flexible policy. Moreover, the Area
Investment Strategy Model does not require prior specification of afuture plan. The
value of an investment decision is not measured by a so-called “ deferral credit” based
on an arbitrary future investment. Instead, only actual cash flows, for both capital and
operating costs, are used to determine the best strategy.

The model can be used to perform traditional deterministic scenario analysis as well
as the more appropriate analysis under uncertainty. In 5 we provide an examplein
which the model is used to compare the results of scenario analysis to the results of a
full analysis under uncertainty. The example demonstrates that addressing issues such
as management flexibility and learning can fundamentally affect policy. Scenario
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analysis will often produce the wrong policy and, in so doing, incorrectly estimate the
costs of al policies.

313 Reformulation of Distribution Investment Planning

The new approach to investment planning requires reformulation of the investment
objective and the analysis methods. The key aspects of this reformulation are
described below.

Structure the Problem Recognizing The System Nature Of Distribution Planning

Electric distribution systems are complex structures. They are composed of
interconnected transmission and distribution circuits and associated transformers,
switches and relays. Because the systems are composed of interconnected
components, identifying alternatives for increasing capacity and expanding the
systems over time requires identifying specific load-growth locations and the
bottlenecks in the system that limit capacity.

Problem structuring involves specifying the capacity problem being solved and
identifying feasible alternative solutions. The inputs to the problem include the load
growth that will be experienced, the current structure of the distribution system, and
the alternatives available for installation. The constraintsinclude the capacity
bottlenecks. The solutions are sequences of investments that provide the required
capacity asload develops. Our experienceisthat problem structuring is
fundamentally an issue of doing careful thinking about the problem and far less a
matter of doing engineering analysis and running load flow models.

Remove Deferral Bias

The objective of distribution investmentsis the same as that of any other investment
in infrastructure: minimize the cost of service subject to meeting appropriate
reliability and obligation to serve constraints. Meeting this objective may entail the
delay of moretraditional infrastructure investments, but such delay isin no way the
investment objective.

The EPRI approach to distribution investment planning is designed to remove the
deferral biasthat is present in the current view of using small, modular investments
(for example, DR or distributed resources) to defer larger infrastructure capacity
investments. Instead of selecting modular investments to defer planned capacity
installations, the new approach selects the smaller investments to minimize the cost of
service. This removesthe deferral bias. In order to accomplish this selection, the
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investment strategy problemisformulated as an optimization problem. Given that
formulation, economic analysis correctly identifies the least-cost strategy., Problem
formulation is fundamental. If the problem isformulated incorrectly, the wrong
answer will be found, or at least the best solution will be found only by accident.

Base Calculations on Actual Cash Flows

Thefirst change in economic analysisis that the actual cash flows, capital plus
operating, are used in the analysis. One should eliminate the use of arbitrary marginal
avoided costs wherever possible.

Select Modular Investmentsto Hedge Against Future Uncertainties

The main benefit of modular investments (portable substations, engines, and other
small options) istheir ability to delay large infrastructure investments until the need
for those latter investmentsis more clearly understood. Indeed, it is possible that the
need will never materialize, but it is almost certainly not true that their main benefit
comes from deferring indefinitely, thus replacing, substations or feeders. Modular
investments are not a substitute for infrastructure investments. Their real value is that
they permit the planner to wait, or fill a gap, without making arisky, large, long-lived
capital commitment.

This objective is not inconsistent with minimizing the cost of service. Infact, inthe
context of finding the optimal investment policy, the hedging possibilities are only
selected when they provide | east-cost solutions.

The physical nature of the modular investmentsis what permits them to be used as
hedges and what prevents them from being used as substitutes for infrastructure. By
definition modular investments come in relatively small capacity increments. They
are flexible, since they can be relatively easily sited and, in many cases, moved from
one location to another in the distribution system.

The value of modular investments as hedging investments can be found by specifying
the uncertainties in a distribution area and finding the best investment policy. The
EPRI-supported analysisis designed to do that. It isimportant to note that the value
of modularity increases as the uncertaintiesincrease. The optimal investment policy
islesslikely to include modular optionsif thereisrelatively little uncertainty. Thisis
because the additional cost of modularity and flexibility is not justifiable if the future
can be treated as if it were known.
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Explicitly Incor porate Uncertainty Into The Analysis:

Load Growth Uncertainty: For distribution planning, akey issueis at what point in
the future will load growth result in new capacity requirements. A complete
description of potential load trajectories over timeis required in order to specify the
probability distribution on the time that new capacity is required.

The uncertain load growth should be characterized dynamically. Most distribution
planners believe that load growth can be usefully described in terms of multiple
possible trends that can persist for uncertain durations. A simple model, such asa
linear fit to load data, misses the dynamic behavior of the trends. Further, itis
essential that the variance in the load on the distribution system not be
underestimated. Again, asimple model, such as alinear fit to observed load data, will
consistently underestimate the variance in the load compared with a dynamic
probabilistic model.

A successful dynamic model will have minimal data requirements while preserving
the appropriate degree of accuracy and variation that aload forecast ought to exhibit.
The inputs to the model should be based on user assessments. The assessment
procedure should be simple and transparent, which means that the user should find it
both easy to use and easy to understand.

Sting Uncertainty: Among the important uncertainties that must be addressed by
distribution plannersis siting uncertainty. A critical issue is whether siteswill be
available for infrastructure investments. The relative likelihood of site availability for
substations, feeders, and other investmentsis a strategic issue. Whether or not a site
must be secured before it is actually needed becomes a strategic decision, depending
on whether it is easy or not to obtain asite. Further, the effects of regulatory and
environmental considerations must be addressed since these effects can influence
investment strategy. There are several ways to address these issues. Perhaps the
simplest isto permit the probability of obtaining asite to vary with time. Another
approach isto trand ate site uncertainty into a cost of delay in obtaining a site.

Operating Cost Uncertainty: Operating costs of various technologiesis an effect that
must be considered by planners. For example, operating local generation technologies
in uncertain conditions makes them somewhat risky. To the extent that different fuels
are used by alternate technologies, the differential amounts of uncertainty in future
prices can have an effect on choice of investments. The simplest approach to
incorporating fuel price uncertainty isto assign a probability distribution to the future
cost of fuels. Perhaps the expected value and the variance would be sufficient for
most applications.

Technology Uncertainty: The uncertainty in technology, either in what is available or
what it may cost in the future, is an important aspect of the strategic assessment of
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DR. For example, athough the current capital costs of both photovoltaics and fuel
cells are sufficiently large so that neither of these technologies can be generally
adopted, the future situation may be different. The consequence of using current DR
technologiesto delay while waiting for some cost reductions to occur in these other
technol ogies can be discovered.

User-specified Uncertainties: In general, any user-specified uncertainty should be
brought into the analysis. Some cases require modeling the effect of weather on the
demand for energy. In other cases, the planners may need to analyze the effects of a
single customer’ s decisions, about which they are uncertain. Although the
fundamental uncertainties are those listed above, others are worth analyzing if the
planner believes that such uncertainties have important effects on system performance
and requirements. Any modeling approach or analysis technique must be flexible
enough to permit such considerations to be incorporated.

Integrate M odular InvestmentsInto Existing Expansion Plans:

If thereisan existing plan for alocal area, it will be of some interest to see whether
integrating modular alternatives can yield amodified plan that is superior. A typical
approach to determine how best to integrate modular considerations would be to
consider whether it would be |least-cost (or lower cost) to delay the investmentsin the
plan. Some delicacy isrequired in such an instance, however. It isimportant to
recognize that deferring assets may be beneficial but need not be optimal. Although
improvements to existing plans may be achieved, there is no theory that indicates that
such improved plans are the best that can be found.

Since many distribution areas do not have a plan, and since distribution investing
appears to be reactive, it is more likely that the modular investments would be part of
an evolving expansion plan. The EPRI approach to this problem suggests two
innovations. First, the distribution system should be recognized as a subsystem that
requiresits own planning function. This consideration applies not only to the
integrated utility but also to any other business organizations that may emergein
future. Astheindustry restructures and if the "poles and wires business' emergesasa
separate entity, such recognition would be a natural result. Second, planners and other
utility (or distribution company) managers ought to recognize that a plan is a policy
that describes not just what to do next year but also what to do as the need for capacity
evolves over time.

Identify Dynamically Optimal Investment Strategy:

The investment strategy that best utilizes modular investmentsis a dynamically
optimal strategy that minimizes the expected net present value of the costs of
acquiring and operating the investments over their useful lifetimes. The dynamically
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optimal strategy is a plan of what to do currently and what to do as uncertainties
resolve over time. While the main focus may be on finding an immediate solution to a
capacity problem, the least-cost near-term decision cannot be found without taking
into account future possible conditions and decisions. Special modeling approaches
and algorithms must be applied in order to determine such a strategy. These
approaches have been built into the Area Investment Strategy Model.

314 The Analytical Problem

This subsection describes the economic valuation principles and the analytical
guestions that must be addressed when solving the investment strategy problem. The
analytical questions are: (1) scale economies of the investment alternatives, (2)
limited scope for modular investments (distributed resources and load control
programs), (3) uncertain future load and costs, and (4) the need to include load control
programs as part of the portfolio of investment alternatives.

Investment Valuation Principles:

Investment capacity planning is guided by a set of economic valuation principles.
Four key principles are stated below. These underlie value estimation for the new DR
and distribution planning methodology.

1. Deferral of capital projects has direct economic value. Thisisthe result of the
opportunity cost of financia capital — the discount rate when doing net present
value calculations. The higher the cost of financial capital the greater the value of
deferral. If the cost of capital were zero there would be no pure capital cost
savings due to deferral. Large investments providing over capacity in the near-
term can be good investments. The value of large investments depends on the
cost of alternative smaller investments and on the eventual load — they can be ok
if the capacity is eventually needed.

2. Thereisatradeoff between economy of scale and flexibility. Big resources are
generally cheaper per unit capacity but provide limited future decision flexibility.
Small investments defer big investments and provide the option to revisit the big
decision. This option to delay allows for the potential for learning before
deciding.

3. Thevaue of being ableto revisit alarge investment decision depends on the
nature of load uncertainty. If thereis no uncertainty, there is no potential for
learning and no value associated with revisiting the decision. Even with
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uncertainty, if the uncertainty is not reduced over time, thereis no value
associated with delaying to revisit the decision.

4. Independent of uncertainty, modularity has value. Small increments of capacity
track load more closely and can be easier to site.

Scale Economies - The“ Two-Edged Sword:”

In most cases, there are scale economies associated with larger capacity investments.
If this were not so, the solution to the investment problem would be obvious: make
small capacity investments that match the load as closely as possible. Scale
economies suggest that it may make sense to invest in alarge increase in delivery
capacity if that capacity will eventually be needed. Hence, the main question is when
toinvest in the large-scale technologies. Two kinds of errors can result from an
incorrect analysis of the benefits of economics of scale. Thefirst error isto avoid a
big investment because the first cost islarge but, in fact, the big investment is the least
cost strategy. The second error occurs if abig investment is made because the unit
cost isrelatively small but that investment, when correctly evaluated, is not the least
cost choice.

Limitation of Scope - Modular Investments & DSM:

Interest in incremental investment strategiesisincreasing. Planners are starting to
recognize that local, small-scale generation and |oad management options, also known
as distributed resources, can provide at |east atemporary alternative to traditional
upgrades. The investment question is under what conditions should traditional
upgrades be avoided by exercising modular options to meet uncertain customer needs
for reliable and economic service? The answer to this question must be based on two
facts. First, the marginal cost of those investments tends to increase, such that if
modular investments are pursued aggressively, the cost of providing a fixed increment
of capacity increases. Thisisillustrated in Figure 3.1.
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Figure 3.1 Limitation of Scope

Second, thereis a physical limitation on the effect of modular and DSM investments.
It may not be possible to locate the distributed assets where they are needed. Itis
possible that the capacity reduction effect of these investments will be limited. This

situation isillustrated in Figure 3.2.
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Figure 3.2 Physical Limit on Capacity
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Uncertainty in Value of | nvestments:

The need for investments, and thus their value, can be very uncertain; current
assessment of value depends on predictions of load, costs, and technology far into the
future. In most cases, future load is an important uncertainty. Distribution
infrastructure investments tend to come in large sizes, and onceinstalled, last for a
very long time. Because of their longevity, the investments are exposed to the risk
that the forecasts of 1oad, upon which the acquisition decisions were based, will not be
accurate.

Load uncertainty makes the scale of distribution investments an important strategy
issue. Smaller scale units provide a hedge against the risk that loads do not
materialize. Further, because learning may occur over time, small-scal e investments
provide the opportunity to delay and revisit large-scale investment decisions.
However if load does eventually materialize or if the cost of the infrastructure
increases as areas develop, there may be significant cost penalties associated with
deferring distribution upgrades using small-scal e distributed technologies. Figure 3.3
suggests that the preferred choice between a Large or Small capacity investment
depends on the forecast of |oad growth. For slowly growing load, the lower
trajectory, a series of small capacity incrementsisbest. If load isforecast to grow
rapidly, then the large capacity alternative is superior.

i
o

Figure 3.3 The Dilemma of Uncertainty
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L oad Management Programs

A fourth source of complexity is the existence of load management programs. System
engineering combined with market intelligence can (1) establish some appropriate
level of unplanned outages (unserved energy), and (2) identify investment alternatives
that provide the commensurate level of service. It may also make senseto have
selective outages for some customers (planned unserved energy). In some situations,
such load management programs may be one of the more cost-effective aternatives
for providing peak capacity relief. If thisistrue, these programs should be treated as
an infrastructure investment alternative. Load management programs also give the
planner the opportunity to fine-tune the level of service provided to individual
customers as part of a complete investment strategy.

55



CHAPTER 3 BASC CONCEPTS

3.2 Model Description

EPRI, in conjunction with a number of utilities, has devel oped a new analytical
approach for distribution infrastructure investment planning. The Area Investment
Strategy Model is an integral part of this new approach. In this subsection we
summarize the new approach and the associated analytical tools.

The new strategy development process builds on current reliability-focused planning.
The approach is atwo-step process. First, system engineering is used to establish the
capacity of the existing local area distribution network and to identify alternative
investment sequences that provide enough capacity to maintain a given service level.
The Area Investment Strategy Model is then used to identify optimal sequences of
investments that are conditional on future load conditions and other uncertainties. The
sequences describe which investment to make today and how to respond as load and
other uncertainties are resolved. The sequences are optimal since they provide the
pre-defined level of service at least cost.

The Area Investment Strategy Model captures the uncertainty of future load and costs
in the design of plans for infrastructure additions. It provides the cost and risk
information utilities need to build business cases for least-cost investment strategies.

The model provides an analytic framework for users to specify alternatives,
characterize important uncertainties, and devel op strategies that minimize the
expected cost of meeting future customer needs. The Area Investment Strategy Model
is the only distribution-planning tool currently available that includes analysis of
future load and cost uncertainties, and develops least-cost plans given the future
uncertainties. The model allows joint consideration of T&D upgrades and distributed
resources, including load management programs.

The Area Investment Strategy Model produces probabilistic descriptions of future
load conditions, given asimple set of user inputs. This part of the model is also
available on a stand-alone basis. Usersinterested in load forecasting can use the Load
Dynamics Model. Theload forecasting model provides: (1) the probability of being at
agiven load level for any year in the planning period, and (2) the probability
distribution on the time that it will take load to reach a given level.
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321 Purpose of the Area I nvestment Strategy M odel

The purpose of the Area Investment Strategy Model isto enable the user to determine
local distribution area expansion plansthat are least-cost under uncertainty.

An expansion plan is atimed sequence of investment decisions that is contingent upon
the future occurrence of various states of nature. For example, if load in an areawere
to begin to grow rapidly, the optimal expansion plan would recognize the need for
capacity expansion in the area sooner than it would if load were growing less rapidly.
The expansion plan itself is described in a contingent manner: e.g., install capacity
amount A of type X at timet; if load growth israpid, install capacity amount B of
typeY attimet, if load growth is moderate, and install capacity amount C of type Z at
timets if load growth is slow.

L east-cost under uncertainty refers to the fact that the optimal expansion plan will be
the one whose expected net present value is smallest compared to all feasible
expansion plans considered in the analysis. Uncertainty means that the planning
context isone in which the user’s lack of surety about future conditions of load
growth, fuel costs, regulatory environment, technological progress, site availability,
and possibly other important variables, is a major influence on the investment
decisions actually made.

The appropriate investments when future load on the distribution system is certain are
very different than those when future load is uncertain. It isthat difference that
motivated the construction of the strategy model. When future conditions are
uncertain, then future cash flows are uncertain, and the optimal policy minimizesthe
expected present value over al future cash flows, where by expected we mean the
probability-weighted average of the uncertain cash flows.

Unlike other models that rely on very complex and detailed data inputs, the strategy
model requiresrelatively little in terms of data. Thisis because the design of the
strategy model replaces the need for data with a sophisticated model structure that can
extract, from the data, sufficient information to determine optimal investment
strategies. The fundamental model design tradeoff is between a primitive model
structure driven by exhaustive data sets compared to a mathematically robust model,
with internal optimization logic, that requires an easily assembled data set.
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322 Data Requirements

There are eight categories of datarequired in the strategy model.
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Basic Planning Data. The basic dataincludes (a) a specification of the planning
period over which specific decisions will be made, measured in years; (b) the
appropriate discount rate for future cash flows, expressed as a decimal; (c) the
applicableinflation rate, expressed as a decimal, and (d) the tax rate, expressed as
adecimal.

Load Growth Specifications. The load growth is characterized using the
parameters of the Load Model. These parameters include a collection of load
growth rates, an initial peak load value, an initial load growth rate, and a matrix
that captures the probability of making atransition between any two growth rates
in each year of the planning period.

The Load Model describes the dynamics of peak load in the distribution planning
area by specifying the way load growth rates change over time. The model treats
load growth as a random process such that each year a particular growth rate
applies but the load growth for the next year is selected randomly, conditional on
the current growth rate.

Asmany as five distinct growth rates may be specified by the user. For each
growth rate, the probability distribution on the next growth rate—the one that will
apply in the next year—is required. Thisdistribution can be thought of as arow
in amatrix of probabilities. Each element in the matrix is the probability of
making atransition from the initial growth rate (specified by the row) to the final
growth rate (specified by the column). The sum of the probabilities in each row
must equal one. The collection of rows defines the transition matrix.

Theinitial load (kW) on the distribution system must also be reported. This
provides the base for future growth. The initial load growth rate must also be
provided by the user. Thisvalue must be bounded by the largest and smallest
growth rates specified.

Load Duration Curve. Theload duration curve for the local distribution areais
required. The curveis approximated by a piecewise linear function. The user
provides up to 20 points on the curve, with coordinates (hour, % of peak load).
Asload grows, according to the Load Dynamics Model, the peak load is increased
but the percentages are preserved, so that the load duration curve's relative shape
is preserved.
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Capacity Alternatives. This data describes the aternatives available to a
distribution planner to achieve capacity needs. The strategy model treats two
kinds of alternatives, strategic alternatives and so-called "bandaids." The strategic
aternatives are typically large-scale capacity additions that can be selected in any
order along atragjectory. The bandaids have typically smaller capacities and can
be selected in afixed order. That order isimplicitly specified by the user when
the bandaids are entered into the model; i.e., the model assumes that the bandaids
are entered in the sequence in which they will beinstalled. That sequenceis
independent of any strategic investments that may be installed along the
trajectory.

Typical strategic alternatives are feeders or substations. Capacitors, small engines
and other distributed technologies such as batteries and DSM can be thought of as
bandaids. The model is ableto analyze distributed generation and storage |ocated
throughout the distribution system as either strategic alternatives or as bandaids.
The user must specify a sequence of distributed alternatives if those alternatives
are to be considered as bandaids.

Each alternative must be named; the capacity (measured in kW) must be
specified; the purchase cost (in thousands of dollars) and cost escalation (other
than inflation, specified as a multiplier) are required; the lead time for each
alternative, measured in years, is that time between commitment to install a new
asset and when the capacity is actually available; the lifeis the useful life of the
asset.

It isimportant to note that the strategy model interprets the capacity value
specified for each alternative as the peak-load-relieving capacity provided by the
aternative. Capacity additions are required when peak load equal s the total
installed capacity. Therefore, when an investment is made, the total installed
capacity increases by the capacity of that investment. Thus, each capacity
addition satisfies load growth until the peak load increases by exactly the capacity
that was added.

Operating Costs. Each of the capacity alternatives described in 4, above, isaso
characterized with respect to operating costs. The model requires the fixed
operating and maintenance (O& M) costs (measured in $/yr.); appropriate fuel
costs, the heat rate, as applicable, of each alternative; variable O&M, as
appropriate; and the value, per kWh, of system energy cost for each of the
alternatives, which is used as an energy credit if appropriate.

Installation Constraints. This data describes restrictions on alternatives within a
policy. A policy can be thought of as a sequence of investments; an investment
provides capacity in response to load growth. Therefore, policies vary with
respect to type of investments, ordering of investments as the policy extends over
time, and timing of investments in response to load growth. The constraints
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restrict the possible sequences with respect to quantity and precedence of
investment alternatives. The quantity constraints indicate how many times an
alternative may be repeated within a policy; e.g., there can be at most two
substations installed in the area. The precedence constraints permit flexibility in
combining alternatives. For example, it is straightforward to restrict policies such
that, for alternatives A, B, and C, A cannot occur with B, A must be preceded by
C, A cannot follow B and C, etc. Thisflexibility is aunique and powerful feature
of the Area Investment Strategy Model.

Salvage Value. The salvage value option places a value on the remaining life of
installed assets that are present at the end of the planning period. There are two
options. Thefirst option permits the user to accept alottery on the price or value
of installed capacity at the end of the planning period. The user specifiesthe
expected value of future capacity asarental price ($kW-yr.). A simple equation
convertsthis expected value into the salvage value. This option seems reasonable
if the planner anticipates that a competitive market for distribution capacity will
develop. The second option called the "cost-to-go" estimates the actual policy
cost over the remaining infinite horizon. To apply the "cost-to-go" option, the
user must specify four additional parameters, (i) the average capacity cost in the
future, (ii) the average operating cost in the future, and (iii, iv) the real escalation
rates for each. Then, the infinite horizon cost computation is based on the
additional assumption that an investment is replaced when it comes to the end of
itsuseful life. Thusthereisan infinite stream of replacements of each investment.
A sensitivity analysis can be performed to observe how changesin the salvage
value/cost-to-go affect the optimal policy.

Advanced User. The user may also provide additional data that determines the
way the strategy model actually performsits operations. First, in order to match
the computer memory allocated to the problem with the size of the problem, the
user may select the number of nodes allowed in the model. An advanced user will
recognize that the investment strategy problem isformulated using a decision tree
and that increasing the number of nodesin that decision tree increases the size of
the decision problem that the model will solve. However, increasing the number
of nodes also uses up more of the computer’s memory and tends to slow down run
times. The advanced user may prefer to perform the tradeoff of size and speed
rather than accept the default values in the model.

Second, the model can perform its work using the idea of coal escence.
Coalescence means that all nodes in the decision tree for which the future
description of the decision problemisidentical (i.e., nodes at the same total load
level for which the same collection of technol ogies has been installed) are treated
identically with respect to future computations. When the coal escence option is
enabled, the model only evaluates the earliest repeated node in the decision tree
and uses the results of this evaluation to attach a value on all other similar,
coalesced, nodes. Exercising the coalescence option can dramatically improve the
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run time, but the method is an approximation and can have some effect on the
numerical results.

The advanced user should contact EPRI user support for a detailed explanation of
these options and their potential effects.

3.2.3 Overview of the Operation of the M odel

Formally, the Area Investment Strategy Model is adynamic optimization model. The
capacity expansion problem is formulated as a stochastic optimal control problem
over an infinite horizon. A frequently applied representation of such aproblemis
based on the structure of adecision tree. The tree contains a sequence of nodes; each
nodeis either a decision node or a chance node. At a decision node, a choice of paths
can be made. At achance node, the path that actually occursis not chosen but rather
is governed by a probability distribution. All the uncertain variables in the problem
are modeled using probability distributions on chance nodes. A policy isacomplete
path through the tree, such that the choice made at each decision node is specified
conditionally with respect to the sequence of resolutions of the prior chance and
decision nodes, and the combination of choices and uncertainties determines the cost
along each path. The optimal policy isthe one that minimizes the expected cost
through the tree.

An example of adecision treeis provided in Figure 3.4 below. Beginning at the left,
thefirst decision isto choose between A and B. If A is selected there follows a
chance node. With probability p, no further decisions need be made, whichis
symbolized by the triangle at the end of the branch emanating from the chance node.
With probability 1-p, the next decision is to choose between C and D. Regardless of
which oneis selected, no further decisions arerequired. If B is selected initially, there
follows a chance node such that with probability g, the next decision isto choose
between E and F. Regardless of which one is selected, no further decisions are
required. Alternatively, after B is selected, with probability 1-g, the next decision is
to choose among E, F, and G. Notice that the alternatives can change depending upon
the condition achieved.
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Figure 3.4 A Simple Decision Tree Structure

Choosing E or F means that no further decisions are required. Choosing G leads to
another chance node, such that with probability r, the next decision is between H and
I. Similarly, with probability 1-r, the next decision is between H and |. No further
decisions are required.

A policy isacomplete setting of the decision nodes for every possible resolution of
the chance nodes. Thus, apolicy isaset of contingent actions that specifies what to
do in any state of the world. For example, one policy is: select A at the first decision
node and if the lower branch of the chance node occurs, select C. Hereis an dternate
policy: select B, followed by E if the upper event occurs and G if the lower event
occurs; after G, choose H in either case. The optimal policy isthe path that isleast
cost. The algorithm that determines the optimal policy has only two rules: (1) replace
all chance nodes by their expected cost, and (2) replace all decision nodes by the
aternative with minimum cost over all possible alternatives.

The Area Investment Strategy Model begins by setting up the tree structure, using the
constraints specified by the user to eliminate infeasible paths. The salvage value
specifications provided by the user permit the model to compute the cost at the end of
the tree. Once costs at the end of the tree have been determined, it is straightforward
to compute the expected value of each alternative at each decision node. That
expected value is based on the probabilities of uncertain events, such asload growth,
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as specified by the user. After computing all such expected values, the model
searches the tree to find the path that isleast cost. Results of the Area Investment
Strategy Model analysis are presented in aformat that is consistent with the tree
structure used to solve the problem. Illustrative examples of the tree structure and the
operation of the model are given in Section 3.2.3, below.

3.24 Model Outputs

The model currently produces four output reports.

1. Decision Frequencies. Thisreport indicates which aternatives are installed in

5.

each year of the planning period under the optimal policy. The report isexpressed
as amatrix, with rows corresponding to the alternatives and columns listing the
years. The number in each cell isthe likelihood that a particular alternative will
beinstaled in aparticular year. If the value is 1.000, the alternative is always
installed in that year. Values less than unity indicate that there is some chance
that the alternative is not installed in that year. Empty cells mean that the
aternative is never installed in that year. Note that neither the rows nor columns
must sum to one, since it is not mandatory that every alternative be installed
sometime, nor is it mandatory that some alternative must be installed in each year.
The purpose of the report isto summarize the installations along the optimal
policy, without regard for the contingent aspects of the installation sequence.

Risk Profile. This report describes the probability distribution of the cost of the
optimal policy. The cumulative distribution is specified by a collection of points
that describe the probability that the cost of the policy islessthan or equal to the
lower limit of each cost range. The purpose of the report is to provide a graphical
description of the risk of the optimal policy.

Optimal Tree. Thisreport presents the contingent optimal policy in the form of a
tree. The sequence of decision nodes and chance nodes that describe the optimal
policy is shown. At each decision node, the optimal alternativeis noted. At each
chance node, the probability of each event islisted, followed by the time that the
next decision occurs. If an alternative has sufficient capacity to last until the end
of the planning period, that is noted by the word "Terminate.” The purpose of the
report isto present the optimal policy in asimple graphical format that highlights
the contingent nature of the policy. (See Section 3.2.3, below, for examples of the
optimal tree output report.)

Input Data. This report echoes the input data provided by the user..
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4.1 Introduction

This section discusses the modeling process and provides an example of how the Area
Investment Strategy Model can be used to determine the best investment policy for a
local area and to provide insightsinto the key issues affecting strategic policy. A
sequence of tasks is described, designed to implement the Area Investment Strategy
Model within an organization and to develop the capability to support local area
decision making.

To illustrate the process of getting started with the Strategy Model, the investment-
planning problem of afictitious utility, National Power Company (NAPCO) will be
analyzed. After describing how to set up the model, an initial base case will be
developed from historical data. Thisinitia case will be unrealistically simple; its
purpose is to familiarize the new user with the structure of the problem and the
handling of input data sets. The results of the first case will most likely be too
simplified to use for policy recommendations. An iteration through the analysis cycle
will make the model’ s representation of the electrical system more realistic and
complex. A new input set will be devel oped to represent more accurately the utility’s
electrical problem and demonstrate many of the features of the Strategy Model. The
tasks outlined in this section are designed to increase the user’ s knowledge of how the
model works and how to determine what aspects of a specific problem are important.
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To obtain the software, you must be a member of the Distribution Resources Target or
the Distribution Business Area. A copy of the Strategy Model along with test data
setsis available through:

EPSC/Electric Power Software Center
Suite 120

11025 North Torrey Pines Road
LaJolla, CA 92037

1-800-763-EPSC

(1-800-763-3772)

If you have any problems, you may call Steve Chapel, EPRI, (650) 855-2608.
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4.2 Analysis Cycle

Before assembling input data and starting to run the Area Investment Strategy Model,
it isimportant to examine what the result of the modeling process will be. The
process by which it isused is as important as the model itself. The model isnot a
“black box” that will provide a single answer for the lower cost investment policy.
While the Area Investment Strategy Model will identify the least-cost policy for a
specified set of input parameters, support of investment planning decisionsinvolves a
great deal more than asingle run of the model. Proper analysis is accomplished by
many model runs, cycling through the process depicted in Figure 4.1.

Figure 4.1 Analysis Cycle

The analysis cycle constantly refines one’ s description of the electrical system, testing
the sensitivity of resultsto changesin inputs and identifying the key issues.
Examination of the effects on model results when input data are varied provides a
guantitative understanding of the critical factors that determine capacity regquirements.
The refined input description will not only determine the best investment policy, but
also indicate how costs vary with policy and illustrate the consequences (e.g., capital
and operating costs, investment risks and future |oad probabilities) of following a

policy.
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4.3 Using the Strategy M odel

The Strategy Model requires a personal computer and a planner with experiencein
distribution planning. The planner installs the model on the host computer. The
planner gathers the model data, operates the model, interprets the model results, and
communicates results and insights to policy and decision-makers. Version 1.6is
relatively fast, taking seconds or minutes for atypical case on current PCs.

431 Work with Test Cases

The Strategy Model is shipped with three input data sets discussed in this section,
along with the resulting output sets. Theinput files are casel.aip, case2.aip, and
case3.aip. Theoutput files are casel.Report, etc. These test data sets serve three
purposes.
They:

1.demonstrate that the model has been correctly installed on the computer,

2.provide data sets for the tasks described in this section, and

3.provide templates for future data sets.

4.3.2 Structurethe Problem

It is helpful to analyze investment-planning problemsin general before studying the
specifics of one’ sown situation. This provides a context for the problem and
identifies the issues appropriate for further investigation. It also highlights the items
that will be candidates for sensitivity analysis following initial model runs.
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As discussed earlier, there are five fundamental types of issues that must be evaluated
in order to determine the least-cost expansion strategy for alocal area. Thefirst three
basic issues are economic issues that exist under certainty. The last two issues exist
because the future is uncertain.

Vaue of Lower Life-Cycle Costs
Value of Deferral

Vaue of Tracking Load

Vaue of Flexibility

Value of Learning

Value of Lower Life-Cycle Costs:

Under certainty, the issue of which technology to use to satisfy load isa classical
economics problem. The objective isto minimize the present value of the cost stream
over time among the various alternatives. If two investments have the same size, the
solution is determined by evaluating the tradeoff among capital costs, operating costs,
and investment life. It is easy to demonstrate that the best alternative will be the one
that has the lowest annualized, or levelized, cost.

Value of Deferral:

Deferral of an investment has a direct economic value, which is the opportunity cost
of money. To seethis, consider the examplein Figure 4.2, which shows two
alternatives for meeting load over sometime periodt. One alternativeistoinstall the
larger investment (capacity C, capital cost $X) at time 0, which would serve load until
timet. The other aternativeisto instal the smaller investment (capacity C/2) at time
0 and then again at time t/2. Suppose the operating costs are zero and that the capital
cost of the smaller investment is half the capital cost of the larger investment. In other
words, there are no economies of scale. Also, for simplicity, suppose that t = 2 years.
The present value capital cost of the large aternative is $X. The present value capital
cost of the smaller alternative is $X/2 plus $X/2(1+r), where r is the discount rate.
The discount rate is the cost of capital; for example, if the cost of capital is 10%, this
means one must pay $1.10 in order to finance $1 of investment for ayear. If $X =
$1,000 and r = 0.1, the present value capital cost of the large investment is $1,000,
whereas the present value capital cost of the small investment is $955. The small
investment has an advantage of $45 simply because it defers the capital expenditures.
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Figure 4.2 Benefits of Deferral

The cost of money, or the time value of money asit is sometimes called, is more than
just an abstract economic concept. Note that if the cost of capital (real discount rate)
were zero, there would be no capital cost savings due to deferral.

Value of Tracking L oad:

Continuing the example of Figure 6, it is clear that the smaller investment tracks load
more closely than the larger investment (i.e., the average amount of excess capacity is
smaller with the modular investment). This can generate several additional types of
economic value. For example, suppose that a disruption occurs somewhere else on
the system. If alarger unit isinstalled the average amount of unserved energy will be
less, since there is more excess capacity. On the other hand, if the investments
themselves are unreliable, failure of the large-investment technology would have
twice the negative capacity impact as failure of one of the smaller technologies.
Perhaps the most direct benefit of tracking load comes with must-run generation units.
Note in Figure 6 that any operating cost associated with the excess capacity of the
larger unit istwice the operating cost of the excess capacity of the smaller unit
(compare the areas above the load curve). Perhaps more subtle, but at least as
important for investment planning, are two principles related to the value of modular
investments under uncertainty.

Value of Flexibility:

Big investments are generally cheaper on a per kW basis, but they provide less
flexibility than small investments. Small investments can defer big investments and
provide a potentially valuable option to revisit the question of whether to make a big
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investment. For example, if load growth is uncertain and it is unclear whether alocal
areawill saturate (i.e., hit amaximum load level) at a high or low level, it may be far
less expensive to invest in small investment alternatives and then invest in the larger
aternativesif and only if load grows sufficiently high. The test cases below will
demonstrate (1) that the value of this type of flexibility can be very high, and (2) that
it isimpossible to estimate this value without addressing uncertainty explicitly.

Value of Learning:

The value of flexibility isintimately related to the value of learning about the
investment uncertainties. If an investment uncertainty, such as load growth, is
modeled as an independent process, then, by definition, thereis no learning. For
example, if load in period 2 isindependent of load in period 1, then load being highin
period 1 tells us nothing about the level of load growth in period 2. However, load
growth is agood example of a process in which uncertainties are generally not
independent. For example, it may be more likely that load growth will continue to be
high after three years of high load growth than it would be for load growth to be high
after three years of very low load growth. In this case, we can update our state of
information about future load growth by observing past load growth and “tailor” our
future decisions accordingly. For example, it may be appropriate after observing
several years of high load growth to invest in alarge alternative because the future
load growth necessary to justify such an investment is much more likely
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4.4 NAPCO Example

National Power Company wants to analyze the areainvestment policy for Thapa
County. The Thapa County system currently consists of one small and aging
substation. The basic decision Thapa County’s planners face is whether to replace the
old substation with a new one or whether to install a smaller-capacity feeder and then
possibly use local generators over time if needed to serve load.

44.1 Setting up an Initial Base Case

The first base case constructed will take an intentionally simplified broad-brush
approach to the problem. It will ignore uncertainty in load and differencesin
investment sizes. It will provide a context for setting up the basic model inputs and
will provide an initial planning policy under certainty. While simplistic, this type of
case allows the new user to get the model working and to begin to understand how the
model works. For the experienced user, starting with asimplified case helps to
identify areas in which further refinement of the datais necessary, and provides a
basisfor sensitivity analysis.

For ease of understanding, we shall build up a progression of cases, starting with the
simplest possible case and adding complexity aswe go. Thisisthe recommended
processin areal application. Table 4.1 summarizes the key planning assumptions
common to all cases. Table 4.2 shows the model inputs for the simplest possible base
case.

Note these tables list the key input parameters but not every input parameter for the
tutorial cases. The user can examine all of the data by using the model interface. To
do this open the File menu, select Open Case and select the appropriate input file
from the dialog box. The inputs can then be examined using the Edit menu.

Note: Do NOT attempt to build the cases from scratch using the datain Table

4.1 and Table4.2. Theseare not complete data sets. Usetheinput files
distributed with the software.
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COMMON ASSUMPTIONSFOR ALL CASES

Time Horizon 20 years

Discount Rate 5%
Inflation Rate 0%
Before Tax Cash Flow

100,000 kW

Accounting Method
Initial Load
Terminal Value Specifications

- Price of Capacity at Terminal Time $10/KW-yr.
Variable O&M Costs $0
Emissions Costs 0
L oad Shape T